Cara Instalasi Sistem

1.

Instal aplikasi pendukung yang terdapat pada folder Software

pendukung

a. Install aplikasi “appserv-win32-2.5.10” yang digunakan sebagai
database server, install seperti biasa dan tentukan username dan
password (aplikasi ini hanya di instal di komputer server).

b. Install jdk-6u3-windows-i586-p yang digunakan untuk menjalankan
aplikasi Java.

c. Instal netbeans-6.9.1-ml-java-windows

. Buka browser dan tuliskan http://localhost/ silahkan login dengan

menggunakan username dan password appserv yang diinsstall

sebelumnya.

. Setelah login buat database baru dengan nama bangunandb dan

import database yang sudah disediakan di folder Databases,
“bangunandb.sql (Empty).zip” (untuk database yang kosong) dan
“bangunandb.sqgl (Data UD).zip” (untuk data yang berisi data UD Atmo
Putro).

. Buka folder Project -> AppPembelian > lib buka mengunakan

textpad/notepad file “database.ini” ganti tulisan “localhost:3306"
dengan alamat ip server dan portnya (untuk default appserv
(localhost:3306), bagian “DBUsername” isikan dengan nama

username appserv dan “"DBPassword” dengan password appserv.

. Buka program dengan Netbeans pada folder Project -

AppPembelian


http://localhost/

Penggunaan Sistem

A. Menu Admin/Pemilik UD
1. Jalankan Sistem Pembelian maka akan tampil form login seperti

berikut:

Masukan username dengan nama admin dan password admin.

2. Apabila login sebagai admin berhasil maka akan menampilkan form
Pemilik UD, dimana pada form pemilik UD ini memiliki 3 menu yaitu
Data User, Hak Akses User dan Laporan berikut adalah tampilan dari
form Pemilik UD:

Fungsi dari menu-menu tersebut adalah seperti berikut :
> Data User : berfungsi untuk menambahkan/menghapus user
baik user Pemilik UD maupun Pegawai UD. Tampilan dari form
data user tersebut adalah seperti berikut:



Pada form tersebut silahkan tambahkan user untuk pegawai ud,
dan tentukan juga username dan passwornya, kemudian tekan
simpan.

Hak Akses User : digunakan untuk memberikan hak akses
pada user pegawai ud. Tampilan dari form hak akses ini adalah

Pada form ini silahkan klik combobox pada bagian username,
kemudian pilih username pegawai ud vyang tadi telah
ditambahkan maka akan tampil informasi pegawai tersebut dan
tentukan hak aksesnya setelah itu simpan.



» Laporan: menu laporan ini berisi menu-menu laporan yang ada

Pada menu laporan ini dapat kita pilih laporan yang kita inginkan
dimana beberapa menu apabila kita pilih maka akan
menampilkan laporan (laporan nilai persediaan, laporan hutang
belum di bayar dan laporan kurang dari minimum) dan beberapa
akan menampilkan form inputan seperti input tanggal periode
yang di masukan tanggal dari dan hingga (laporan pembelian,
laporan retur pembelian dan laporan laba kotor) berikut adalah
contoh form input laporan dengan periode :




Pada form tersebut isikan dengan tangal periode yaitu input
tanggal dari dan tanggal hingga kemudian klik “Preview” maka
laporan akan di tampilkan, pada laporan persediaan barang kita
masukan kode barang dan periode, berikut adalah tampilan form
input laporan persediaan barang:

Pada form ini masukan kode barang dengan cara tekan button
yang ada di bagian kanan kode barang maka akan menampilkan
semua data barang yang tampilanya seperti berikut:

(Bt e

Nama Barang Jenis

Semen Gresik (SAK) Semen
Gamping Mill Lain-lain
Gamping Lain-lain
|Pipa Wavin 12" Pipa
Pipa Wavin 3/4" Pipa
|Fipa Wavin 1" |Fipa
Pipa Wavin 2" Pipa
|Fipa Wavin 3" |Fipa
Pipa Wavin 4" |gipa
Pipa Listrik Langeng Pipa
Pipa Listrik Biasa Vipon |Pipa

Talang Listrik Lain-lain
Asbes Harkek 180cm  |Asbes




Pada form data barang pilih barang yang akan dilihat laporan
persediaanya, untuk memudahkan pencarian dapat tuliskan
nama barang/kode barang pada textfield pencarian apabila
barang telah ditemukan klik “Ambil Data Barang”, maka kode
barang akan ditampilkan pada form laporan persediaan barang
maka pada persediaan barang kita masukan tanggal periodenya
dan tekan tombol “Preview”.

B. Menu User/Pegawai UD
1. Jalankan Sistem Pembelian maka akan tampil form login seperti
berikut:

Masukan username dan password dengan username dan password
yang telah diberikan Admin/Pemilik UD sebelumnya.

2. Apabila login sebagai pegawai berhasil maka akan menampilkan form
pegawai UD, dimana pada form pegawai UD ini tampilanya seperti
berikut:




3. Pada form utama pegawai ini terdapat beberapa menu yaitu File,
Barang, Vendor, Transaksi dan Laporan. Fungsi dari menu-menu ini
adalah sebagai berikut:

a. Menu File
> File > Ganti Password
Menu ini digunakan untuk membuka form yang digunakan untuk
mengganti password pegawai yang sebelumnya password sudah
diberikan oleh pemilik UD.

> File 2 Log Out
Menu ini digunakan untuk keluar dari sistem dan kembali ke
login sistem.

> File > Exit
Menu ini digunakanuntuk keluar dari sistem pembelian.

b. Menu Barang
> Barang - Data Barang
Data barang digunakan untuk melihat informasi barang dimana
pada form data barang ini terdapat tombol tambah barang,
hapus/edit barang dan detail barang, berikut adalah tampilan
dari data barang :

Nama Barang Jenis Harga Jual

Semen Gresik (SAK) Semen
Gamping Mill Lain-lain
Gamping Lain-lain
Pipa Wavin 1/2" Pipa
4 Pipa Wavin 3/4" Pipa
|BGD00006 Pipa Wavin 1" Pipa
|BG000007 Pipa Wavin 2" Pipa
[BG0O00008 Pipa Wavin 3" Pipa
|BGD00009 Pipa Wavin 4" Pipa
[BG000010 Pipa Listrik Langeng Pipa
BG000011 Pipa Listrik Biasa Vipon  |Pipa
|BG000012 Talang Listrik Lain-lain
[BG000013 Asbes Harkek 180cm  |Asbes

R 4 Acha B iah 240 Acha

Ambil Data Barang

Tambah

Close




Untuk menambahkan barang kita dapat memilih tombol
“Tambah” barang dan memasukan data barang dan di simpan.
Untuk meghapus/edit dapat dilakukan dengan cara memilih
barang pada tabel dan tekan tombol ubah/hapus maka akan
menampilkan from barang dan pada form tersebut untuk edit
kita dapat mengubah data barang dan tekan tombol “Ubah” dan
untuk menghapus kita dapat lakukan dengan menekan tombol
“Hapus”, untuk melihat detail barang dapat dilakukan dengan
memilih barang pada tabel dan menekan tombol “Detail Barang”
maka akan tampil detail barang yang dipilih.

Barang 2> Konversi Satuan
Konversi satuan digunakan untuk mengonversi satuan barang.
tampilan form konversi barang adalah seperti berikut :

Pada form ini klik tombol “Pilih Barang yang akan dikonversi”
maka akan menampilkan form data barang, seperti sebelumnya
kita dapat memilih barang dengan bantuan pencarian yang
tersedia jika barang ditemukan tekan tombol “Ambil Data
Barang akan dikonversi” maka akan kembali ke form konversi
dengan menampilkan informasi barang yang akan di konversi,
pada bagian ini isikan jumlah barang yang akan di konversi.
Tahap kedua adalah klik tombol “Pilih barang hasil jadi” maka
akan menampilkan form data barang, seperti sebelumnya kita
dapat memilih barang dengan bantuan pencarian yang tersedia



jika barang ditemukan tekan tombol "“Ambil Data Barang Hasil
Konversi” maka akan kembali ke form konversi dengan
menampilkan informasi barang hasil konversi, pada bagian ini
isikan jumlah hasil konversinya, maka akan di tampilkan harga
pokok produk setelah itu dengan melihat harga pokok produk
kita tentukan harga jual harga hasil konversinya, jika sudah
tekan tombol "Konv” maka konversi akan di simpan.

» Barang > Koreksi Stok Barang
Koreksi stok barang digunakan untuk mengoreksi stok apabila
jumlah fisik dengan jumlah pada sistem berbeda. tampilan form
koreksi stok adalah seperti berikut :

| Koreksi Stok Bara

Kd Barang Nama Barang Jenis Stok Satuan

BG000001 Semen Gresik (SAK) Semen 90 Sak
Gamping Mill Lain-lain 50 Sak I ﬂ

Lain-lain 24 Sak
Pipa 11 IPcs

BG000004

Pipa 14

BG000007

Pipa 11
Pipa Listrik Langeng Pipa 121

Close

Pada form ini kita memilih data barang yang akan di koreksi
kemudian pilih barang tersebut maka akan di tampilkan
informasi data barang dan pada jumlah koreksi di rubah jumlah
fisik yang ada.

c. Menu Vendor
> Vendor 2> Data Vendor
Data vendor digunakan untuk melihat informasi vendor dimana
pada form data vendor ini terdapat tombol tambah vendor,
hapus/edit vendor dan detail vendor, berikut adalah tampilan
dari data vendor :



Nama Perusahaan Alamat Kota No Telp

Gandrung Jl. Nitiprayan Utara, Ngesti... [Bantul 10274-2149588
PT Varia Usaha Jl. Raya Janti Bantul 0274-3733932
UD Hendi Jaya \Yogyakarta 108157955503

Matahari Jaya Jl. Raya Gendol Km. 4 Kara... [Sleman 0274-7492228
BIN Bintang Jaya Niaga Jl. Gatot Subroto BlokXI N... |Semarang -

E 'Wahana Wholesale 'Temangung 'Temangung 10811266069
\VE00007 PT. Multi Inocitra Tbk. Jl. Cendung Timur No 73-74  |Jakarta -

Untuk menambahkan vendor kita dapat memilih tombol
“Tambah” vendor dan memasukan data vendor dan di simpan.
Untuk meghapus/edit dapat dilakukan dengan cara memilih
vendor pada tabel dan tekan tombol ubah/hapus maka akan
menampilkan from vendor dan pada form tersebut untuk edit
kita dapat mengubah data vendor dan tekan tombol “Ubah” dan
untuk menghapus kita dapat lakukan dengan menekan tombol
“Hapus”, untuk melihat detail vendor dapat dilakukan dengan
memilih vendor pada tabel dan menekan tombol “Detail vendor”
maka akan tampil detail vendor yang dipilih.

d. Menu Transaksi
> Transaksi > Pembelian & Pembelian Barang
Form ini digunakan untuk melakukan transaksi pembelian.
Tampilan dari form ini adalah seperti berikut:



Pada form Pembelian ini utuk mengunakan pertama masukan
tanggal pembelian, dan masukan kode vendor (untuk
memasukan kode vendor di lakukan dengan cara menekan
tombol pada kode vendor dan memilih vendor dan ambil data
vendor) maka akan tampil pada form pembelian kode vendor
dan nama vendor, kemudian tekan tombol cari barang dan pilih
barang dan ambil barang maka akan menampilkan informasi
barang tersebut dan masukan harga beli harga jual dan qty beli
setelah itu tekan tombol “+” yang digunakan untuk memasukan
barang dalam daftar beli, jika sudah maka akan menampilkan
Total Pembelian pada Jumlah bayar masukan jumlah uang yang
telah dibayarkan, jika pembayaran uang kurang maka di angap
hutang dan masukan tanggal jatuh temponya kemudian simpan.

Transaksi > Pembelian > Pembayaran Hutang
Form ini digunakan untuk melakukan transaksi pembayaran
hutang. Tampilan dari form ini adalah seperti berikut:

Jumlah Harga




Pada form pembayaran hutang ini masukan kode vendor seperti
biasa setelah itu tekan combobox pada nomor faktur maka akan
menampilkan nomor-nomor faktur yang masih hutang setelah
memilih tekan tombol”Ambil Data Barang” maka akan
ditampilkan data barang yang di beli dan tanggal angsuranya di
sini kita masukan pembayaran angsuran sekarang dan tanggal
pembayaran hutang kemudian tekan “Simpan” maka
pembayaran hutang akan di simpan.

Transaksi > Pembelian > Retur Pembelian
Form ini digunakan untuk melakukan transaksi retur pembelian.
Tampilan dari form ini adalah seperti berikut:

| £%)| Retur Pembelian

o | \

AR

Nama Barang Harga Beli Qty tukar Jumlah Harga Keterangan

Pada form ini masukan kode vendor seperti bisasa dan masukan
tanggal retur, setelah itu pilih barang yang akan di retur dan
tekan tombol “Ambil Data Barang di Beli” maka akan tampil
nama barang dan pilih pada combobox No Faktur di No Faktur ini
adalah no faktur di mana di dalamnya terdapat barang yang
pernah di beli dan akan di retur, setelah itu masukan jumlah
barang yang di retur dan tekan tombol “+” maka barang akan
masuk dalam daftar retur dan tekan tombol "Simpan”.



» Transaksi > Penjualan
Form ini digunakan untuk melakukan transaksi penjualan.
Tampilan dari form ini adalah seperti berikut:

| &| Penjualan Barang

Pada form Penjualan ini utuk mengunakan pertama masukan
tanggal penjualan dan tekan tombol cari barang dan pilih barang
dan ambil barang maka akan menampilkan informasi barang
tersebut dan masukan qty jual setelah itu tekan tombol “+” yang
digunakan untuk memasukan barang dalam daftar barang di
jual, jika sudah maka akan menampilkan Total Pembelian pada
Jumlah bayar masukan jumlah uang yang telah dibayarkan
kemudian tekan tombol “simpan”.

e. Menu Laporan
Laporan - Stok Kurang Dari Minimum
Laporan ini digunakan untuk pegawai UD melihat stok yang kurang
dari minimum sehingga dapat digunakan untuk pengambilan
keputusan pembelian barang.

Laporan - Hutang Belum di Bayar
Laporan ini digunakan untuk melihat hutang-hutang terhadap pihak
vendor yang masih belum terbayar.



